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Objetivo

El objetivo de este manual es guiar a los usuarios a través del proceso de configuracion y
ejecucion de una simulacioén en Fluent para analizar el enfriamiento de un tren de baterias.
Proporciona instrucciones claras y detalladas sobre como definir modelos, asignar materiales,
establecer condiciones de frontera, ejecutar la simulacion y visualizar los resultados, con el
fin de optimizar la gestion térmica y asegurar el rendimiento y seguridad de las baterias.

Destinatarios

Este manual estd dirigido a estudiantes del area de termofluidos que tienen una comprension
basica de la dindmica de fluidos computacional (CFD) y estan interesados en aplicar estos
conocimientos para simular y analizar la gestion térmica de sistemas de baterias utilizando
Fluent.
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Manual de Analisis y Simulacion de Enfriamiento de Tren de Baterias para Automéviles
Eléctricos

Introduccion

A lo largo de este manual, se presentaran los pasos necesarios para configurar los pardmetros
del modelo, definir las condiciones de contorno, seleccionar los modelos fisicos apropiados,
y llevar a cabo el proceso de resolucion. Este enfoque permitird a los usuarios adquirir una
comprension sélida del procedimiento de simulacion y aplicar estos conocimientos a estudios
de caso especificos o proyectos de investigacion relacionados con la gestion térmica de
baterias.

Configuracion Inicial en Workbench y Fluent

1. Abrir ANSYS Workbench: Inicia ANSYS Workbench desde tu equipo.
2. Anadir Fluent al Espacio de Trabajo: En el proyecto de Workbench, arrastra el modulo
de Fluent al espacio de trabajo.

Analysis Systems

B Component Systems

B AcP (Post) bl I
U5 ACP (Pre) > 1
m Autodyn 2 @ Setup 2 )
[ eladecen .

3 | @5 solut =l
@ CFX oiaon 4
& Engineering Data Fluent

el EnSight (Forte)
External Data
@ External Model
B Fluent
B Fluent (with Fluent Meshing)
Forte

@ Geometry

ICEM CFD

3. Abrir el Setup de Fluent: Haz doble clic en el icono de Fluent para abrir la
configuracion inicial.
a. Selecciona 3D para definir la dimension de la simulacion.
b. Marca la opcion Double Precision para aumentar la precision de los célculos.
c. Activala opcion Display Mesh After Reading para visualizar la malla después
de cargarla.



f.

Configura Solver Processes en 2 (este valor puede variar dependiendo del

nimero de nicleos de tu equipo).

Configura Solver GPUs Per Machine en 2 (este valor puede variar
dependiendo de la disponibilidad de GPUs en tu equipo).

Selecciona Start

Nota: Los valores para Solver Processes y Solver GPUs Per Machine deben ajustarse segiin
las capacidades del hardware del equipo en el que se esté trabajando.

B Fluent Launcher 2020 RY (Setting Edit Only) - O X

Fluent Launcher

Simulate a wide range of industrial applications using the general
purpose setup, soive, and post-processing capabilities of ANSYS

Fluent.

—

Dimension

O

® 3p

Options

@ Double Precision

(v) Display Mesh After Reading
(O po not show this panel again

m Load ACT
Parallel (Local Machine)

-

Solver Processes 2 v
Solver GPGPUs per Machine | % o
= 4

v Shoy More Opli v Show Learning Resources
Cancel Help
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Importar y Revisar la Malla en Fluent

1. Importar la Malla

a.

b.

En Fluent, ve a Files > Import >
Mesh.

Selecciona el archivo de malla que
se va a utilizar y cargalo en el
programa.

® & @ = N
File Domain
e

Recorded Mesh Operalions...

Save rroje et

Reload

Read

Write

import

FxT‘):n

n Files
nterpolat

EM Mapping
FSI Mapping

Physics User-Del

< Task Page
General

Mesh.‘r
Case..
Dat
Case & Data..
ABAQUS ’
CFX »
CGNS 4




2. Revisar la Malla

Una vez importada la malla, es importante verificar su integridad y calidad para asegurar una
simulacion precisa.

a. Opcion Check
1. Ve a Mesh > Check

ii. Esta opcion realiza una verificacion basica de la malla para identificar
problemas comunes, como elementos degenerados o negativos, que
pueden afectar la estabilidad y precision de la simulacion.

iii. Es crucial realizar esta verificacion para asegurarse de que la malla sea
adecuada para el céalculo y no presente errores graves que puedan
interrumpir el proceso de simulacion.

Task Page <

3\
General ’ 9,

Mesh

Scale... Check ‘

Report Quality

Display... Units... ‘

b. Report Quality
1. Ve a Mesh > Report Quality.

ii. Esta opcion genera un informe detallado sobre la calidad de la malla,
evaluando aspectos como la ortogonalidad, el skewness y el aspect
ratio de los elementos.

iii. Revisar la calidad de la malla es esencial para garantizar que los
elementos cumplan con los estdndares requeridos, lo que se traduce en
resultados mas confiables y precisos. Una malla de alta calidad
minimiza los errores numéricos y mejora la convergencia del solver.

Task Page <

General ’ ()

Mesh

Scale... Check Report Quality

Display... Units... ‘



Una vez completados estos pasos y verificada la malla, puedes proceder al siguiente paso de

la configuracion y simulacion.

Configuracion de Modelos y Materiales en Fluent

1. Configuracion de Modelos

a. En el panel de configuracion (Setup), ve a Models.
b. Activa la opcion Energy Equation marcando la casilla correspondiente.

Outline View

(3 Cell Zone Conditions
+) [ Boundary Conditions
ﬂ Mesh interfaces
= Dynamic Mesh
[7] Reference Values
17, Reference Frames
f+ Named Expressions
- Solution
9. Methods
Controls
% Report Definitions
+ Q Monitors
@ Cell Registers

.

+

.

<

Task Page

Models

Models

B enegy | X |

vl
27

v Energy Equation

0 |Canu:l Hclp‘

T TEuferian Wall Film - OF

Potential/Li-ion Battery - Off
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c. En el modelo viscoso, selecciona k-epsilon y configura de la siguiente
manera:
i. Selecciona k-epsilon Model y elige Realizable.
ii. Deja el resto de las configuraciones por defecto.

Models o
Multiphase - Off

— B
Viscous - SST k-omega —

Heat Exchanger - Off
Speces - Off ’
Discrete Phase - Off

B viscous Model X
Model Model Constants

Inviscid C2-Epsilon

Laminar 19

n) TKE Prandtl Number
1

TDR Prandti Number

k-epsilon (2 eqn)

Transition k-kl-omega (3 eqn)

1.2
Transition 55T (4 egn
(4 eqn) Energy Prandtl Number
Reynolds Stress (7 eqn) e

Scale-Adaptive Simulation (SAS)

Detached Eddy Simulation (DES) Woall Prandti Number

Large Eddy Simulation (LES) 0.85
k-epsilon Model
Standard
e User-Defined Functions
= Matate Turbulent Viscosity
Near Wall Treatment none \ v
® Standard Wall Functions Prandt! Numbers
Scalable Wall Functions TKE Prandt] Number
Non-Equilibrium Wall Functions none S
Enhanced Wall Treatment TDR Prandti Number
Manter-Lechner none v
User-Defined Wall Functions Energy Prandt! Number
Options none v
Viscous Heating Wall Prandtl Number
Curvature Correction none Dt

Production Limiter



2. Configuracion de Materiales

a. Ve alaseccidon de Materials.

b. Anadir Fluido (Agua):

i. Selecciona Fluid y afiade uno nuevo.
ii. Desde la base de datos de Fluent, selecciona agua y haz clic en Copy
para anadirlo a la lista de materiales del proyecto.

- Setup
& General
+ © Models
& Materials

- &

i Expand All
+ [ cet Collapse All

+ [ Boundary Conditions
+ B3 Mesh interfaces

n Fluent Database Materials

Fluent Fluid Matenals [1/563]

vinyl-trichlorosilane (sicl3ch2ch)
vinvlidene-chloride (ch2ccl2)

water-liquid (h2o<l>)

wood-volatiles (wood_vol)

Copy Materials from Case... Delete
Properties
Density (kg/m3) constant
998.2
Cp (Specific Heat) (y/kg-k) constant
4182
Thermal Conductivity (w/m-K) constant
0.6
Viscosity (kg/m-s) constant

0.001003

Materials

Fluid
air

Sohd
aluminum

=FEE s -

New... Edit... Save [Copyl Help}

Order Materials by
® Name

Chemical Formula

v | View...



c. Anadir Material Personalizado (Bateria):
1. En Solid, afiade un nuevo material.
ii. Configura las propiedades del material personalizado:
1. Nombre del material: Battery

TIRRN

n Create/Edit Materials

Moo Material Type
Ihnm"‘y sold E\,\
ula Huent Solid Materials
baty solid-1 (al)
Mixture
nory
Properties

Density (kg/m3) constant

2018

Cp (Spedific Heat) (j/kg-k) constant

1282

Thermal Conductivity (w/m-k) constant

2.7

Change/Create | | Delete

Simbolo quimico: batt
Densidad constante: 2018 kg/m?
Calor especifico: 1282 J/kg-K

. Conductividad térmica: 2.7 W/m-K

iii. Haz clic en Change/Create para guardar el material.

B (v

v

v

Order Materials by

® Name

Chemical Formula

fluent Database...

'I

User-Defined Database... [

~

-

v

Edit...

Edit...

Edit...



d. Modificar Propiedades del Aluminio:
i. Selecciona Aluminum (ya definido en la base de datos).
ii. Modifica el calor especifico a 891 J/kg-K.
iii. Guarda los cambios.

n Create/Edit Materials X
Name Material Type Order Materials by
aluminum solid v ® Name
Chemical Formula Fluent Solid Materials Chemical Formula
_ SRO—— fluent Database... |
Mixture
| User-Defined Databasc...|
none
Properties
Density (kg/m3) constant v | Edit...
2719
Cp (Spedific Heat) (j/kg- v | Edit...
Thermal Conductivity (w/m-K] constan v || Edit...

202.4

‘v Change/Create lh. Delete | o= rHelp
3. Verificacion de Condiciones de Zona de Celda
a. Ve a Cell Zone Conditions.

b. Visualizar Fluido: m vaucry

(3 Cell Zone Conditions

i. En la lista de Fluid, haz clic = B3 Huid
derecho y selecciona Display. B fuick i ird=on
ii. Esto te permitird visualizar el 2 B8 soi [T
fluido y asegurarte de que los 0. L\
cuerpos marcados  como 0 \ Py
fluidos estian correctamente B rooida Delete
definidos. + £ Mesh | i =
eshir  Copy To Clipboard
Z1 Dynami Import From File...
[2] Referer

aa Export To Hile...
+ I/, Referer

f' Named Type
- Solution
9. Methoc | Display

o Control Add to graphics
> Report




c. Visualizar Sélidos:
i. Realiza el mismo procedimiento para los s6lidos, asegurandote de que
todos los cuerpos sélidos estén correctamente definidos segin sus
propiedades.

- B3 solid J
08 solid_plas~ -~k -
B wall genn  Fdt...
3 Boundary Cond  Copy..
a Mesh Interfaces Delete
= Dynamic Mesh
D Reference Value Copy To Cligboard
I, Reference Fram  import From File...
£« Named Express

e Export To File..

% Methods Type >
.~ Contrals :@

Y Report Definitio] Display

TSI Ao Rl

Una vez verificados y configurados correctamente los fluidos y sélidos, clic derecho en la
malla principal, presionar display mesh, seleccionar todo y puedes proceder al siguiente paso
de la configuracion.

n Mesh Display X
Options Edge Type ' p— .
Nodes o Al Surfaces Filler Text ‘:-Ol | E ['.-J =,
v Edges Fealure =) Fluid
V| Faces Outline fluid
Partitions = Inlet
Overset ""et
- Interface
Shrink Factor Feature Angle contact_region-src

contact_region-trg

20
9, : : '_, . contact_region_2-src
[(mrrm ‘ Interior | contact_region_2-trq l
Il\diaccncy... [m:w Surface ,|

Display HICO'O'S'” | I Close } I Hclp_]



Asignacion de Propiedades y Condiciones de Frontera

1. Asignacion de Propiedades a las Partes del Sistema
a. Ve a Cell Zone Conditions.
b. Asignar Material a la Bateria
i. Selecciona el cuerpo de la bateria.

ii. Asigna el material Battery que definimos anteriormente.
iii. Activa Source Terms y haz clic en Edit.
iv. Marca la opcion de Constant y establece el valor en 42400.
v. Guarda los cambios.

ST

= 2 cell Zone Conditions

= O Fluid
O fluid (fuid, id=9) I soid N
- 3 solid Zone Name
vl — wall_generation
3 wall_generation (solid, id=10) _—
-0 daecandt Material Npme  aluminum Edit...
+ 3 Inlet Frame Motion Source | erms
+ [ Interface
+ B internal Mesh Motio Fixed Values
A :1 Outiet Reference Frame Mt Motor Source Terms Fixed Values
+) = wall
+ B2 Mesh interfaces Rotation- Axis Origin Rotation- Axis Direction
2l Dynamic Mesh X (m) o v X -
Ret Values
iz b vimo - Yo .
Zone Name
wall_generation
Material Name | battery v | |EoR...

Frame Motion | v Source Terms

Mesh Motion Fixed Values
Reference Frame Mesh Motion Source Terms
Energy 0 sources F m |
n Energy sources X

)

Number of Energy sources] 1

1. (w/m3) 42400| ~




c. Verificar Material del Chasis

i. Asegurate de que el material asignado al chasis sea Aluminum.

- A; Matenals
- &7 Fluid
& air
&7 water-liquid
-) & solid
ﬂ; aluminum
& battery
= [ Cell Zone Conditions
= 3 Fluid
3 fluid (fluid, id=9)

Zone Name
1 solid_plate

Rotation- Axis Origin

=) [ Boundary Conditions
+ 1: Inlet
+ [ interface

d. Asignar Fluido

B3 sold_plate (sohd, id=8)

n Sohd

ly

Material Namd aluminum v lEdil...i

Frame Motion Source Terms
Mesh Motion Fixed Values

Reference Frame Mesh Moton

X(m) o v || Xi0
Y(m)o v Yo

Z(m)o v |[Z]1

i. Selecciona la zona de fluido
ii. Asegurate de que el fluido asignado sea agua, aparecerd como aire por

defecto

o A’ Matenals
- &7 Flud
& air
&7 water-liquid
-) &¢ solid
&’ alumimum
& battery
=) [ Cell Zone Conditions
«) Flslad

[ fluid (fluid, id=9)

- Esone

LR

fluid

Material Namp air ¥ | |Edit...
Frame Motion 3D Fan Zone Source Terms
Mesh Motion Laminar Zone Fixed Values

Porous Zone

Reference Frame Mesh Motion Porous Zone 3D Fan Zone

Rotation-Axis Origin
X(m)o v

Sourc

Rotation Axi

Embed

Rotati
X0



2. Condiciones de Frontera

a. Ve a Boundary Conditions.

b. Configurar Inlet:
i.

il.

iil.

Selecciona la frontera de entrada (Inlet).
Establece la velocidad en 0.3 m/s.
Establece la temperatura en 298.15 K.

Fllter Text
Zone Name

-) (3 cell Zone Conditions inlet

- B Fluid
B3 fluid (fluid, id=9)
= B solid
O solid_plate (solid, id=8)
53 wall_generation (solid, 1d=10)
= Boundary Conditions
% Inlet
"% inlet (velocity-inlet, id=14)
-3
D mmact_reglon_?-src (interface, i
B3 contact region_2-trg (interface, i¢
B3 contact region_3-src (interface, id
3 contact region_3-trg (interface, id
M contact reaion-see finterface id=

‘ Momentum

+
*
*
*
+

Zone Name

inlat

Momentum Thermal Radiation

n Velocity Inlet

Velocity Specification Method Magnitude, Normal to Boundary

Supersonic/Initial Gauge Pressure (pascal) o
Turbulence

Turbulent Viscosity Ratio 10

Speces

Thermal Radiation Spedes DPM Multphase Potential uos

Reference Frame Absolute

Velocity Magnitude ( m/sl|0_3]

Specification Method Intensity and Viscosity Ratio
Turbulent Intensity (%) 5

DpPM Multphase

Temperature (k) 298.15 LF

0|~

c. Configurar Outlet:

1. Selecciona la
frontera de salida
(Outlet).

Deja todas las
configuraciones

por defecto.

il

Zone Name
outlet

Momentum Thermal Radiation Spedes oPMm Mutiphase Potental uos

Backflow Reference Frame Absolute

Gauge Pressure (pascal) o
1

bt

Backflow Direction Specification Method Normal to Boundary

Pressure Profile Multiplier|1

Backflow Pressure Specfication Total Pressure
Prevent Reverse Flow
Radial Equilibrium Pressure Distribution
Average Pressure Specification
Target Mass Flow Rate

Turbulence
Specification Method Intensity and Viscosity Ratio

Backflow Turbulent Intensity (%) s
Backflow Turbulent Viscosity Ratio 10



Configuracion de Solucion e Inicializacion

1. Configuracion de Métodos

a. Ve a Solution y selecciona Methods.
b. En Scheme, selecciona Simple.
c. Deja el resto de las configuraciones como estan.

Outline View

Fllter Text

&; ar
ﬂ; water-hquid
= &¢ solid
£ aluminum
£¢ battery
=) [ cell Zone Conditions
+ B Fuid
+ B solid
+' [ Boundary Conditions
\J a Mesh interfaces
71 Dynamic Mesh
[7] Reference Values
+) 17, Reference Frames

£ klﬁwrnf royera

Solution
% (Nethods

Controls
% Report Definitions
+ Q Monitors
—-— .

<  Task Page

Solution Methods

Gradient
Least Squares Cell Based

Pressure

Second Order
Momentum

Second Order Upwind
Turbulent Kinetic Energy
First Order Upwind
Turbulent Dissipation Rate
First Order Upwind

Fnerov

Transient Formulation

2. Configuracion de Controles
a. Ve a Controls.
b. Selecciona Limits.
i. Establece la Maximum Static Temperature en 5000 K.
ii. Establece la Minimum Static Temperature en 298.15 K.

Filter Text Solution Controls @
&¢ air l n Solution Limits X
&¢ water hquid (o =
s Minimum Absolute Pressure (pascal) |1 -

- &¢ solid ssure (p ) B |
&¢ aluminum -
& battery Minimum Static Temperature (k) [298.15

=) [ cell Zone Conditions _— ' ,
+ B3 Fluid Maximum Static Temperature (k) 5000
* D So'ld VNZISZ) 1e1s

+ [ Boundary conditions
* a Mesh Interfaces
21 Dynamic Mesh
[F] Reference values
+) 12, Reference Frames
£+ Named Expressions
- Solution

o =
I . Controls I

% Report Definitions
+ Q@ Monitors
@ Cell Registers
& Initialization
+ ® Calculation Activities
® Run Calculation
= Results
@ surfaces

- M P b

Minimum Turb. Dissipation Rate (m2/s3) 1e-20

Maximum Turb. Viscosity Ratio | 100000

m {l)ofmm' | ‘:(;1ncol ‘ lﬂl

Turbulent Dissipation Rate
0.8

Turbulent Viscosty

1

Energy

1

]. Default |

| Equations... Limits... Advanced... |




3. Inicializacion
a. Ve a Initialization.
b. Selecciona Standard Initialization.
c. Deja todas las configuraciones como estan.
d. Haz clic en Initialize.

na Inkaizaton
Filter Text ® Standard Initialization

&7 air q Compute from
&¢ water hiquid v
o & Solid Reference Frame
s
St ® Relative to Cell Zone
& battery s
=) [ cell Zone Conditions Sokke
+ B ruid Initial Values
* O solig - Gauge Pressure (pascal)
+ [0 Boundary Conditions o
* ﬂ Mesh interfaces
Z1 Dynamic Mesh X Velocity (m/s)
[Z] Reference values 0
+) 12, Reference Frames ¥ Velocity (m/s)
f+ Named Expressions 0
- Solution
% Methods Z velodty (m/s)
Controls 0

* Report Definitions
+ Q Monitors

Turbulent Kinetic Energy (m2/s2)
1

Turbulent Dissipation Rate (m2/s3)
1

® Run Calculation Temnerature (k) k
- Results R
@ surfaces Initialize | |Resez| Patch...

4. Ejecutar Célculo
a. Ve a Run Calculation.
b. Haz clic en Check Case y revisa las recomendaciones proporcionadas por
Fluent.
c. En Parameters, establece Number of Iterations en 600.
Deja el resto de las configuraciones por defecto.
e. Haz clic en Calculate para iniciar la simulacion.

i Run Calculation @|
& air B ]
& water-liquid | Check Case... Update Dynamic Mesh... |
=) & solid
s oy
¢ aluminum
&7 battery Number of Tterations Reporting Interval
= [ cell Zone Conditions 600 = I -
+ B Fuid Profile Update Interval
+ B solid =
1 -

+ [0 Boundary Conditions
* ﬂ Mesh Interfaces
Z1 Dynamic Mesh
[7] Reference values
+ 12, Reference Frames
£+ Named Expressions
- Solution

Solution Processing
Statistics

Data Sampling for Steady Statistics

Data File Quantities...

o e
Pt e Solution Advancement
Controls - =
™ Report Definitions Calwl}le |
+ Q@ Monitors

@ Cell Registers
&% Initialization

Calculation Activilies
& Run Calculation




Residuals
— continuity
— x-velocity
yvelocity
— zvelocity

1e+t04

1e+02
energy

—

epsilon 1e+00

1e-02 o
1e04 3
1e-06

1e-08

1e-10

T T T

100 150

T T

200 250

T T

300

Iterations

Visualizacion de Resultados y Guardado

1. Visualizacion de Resultados

° oo o

I i L

Outline View

Filter Te

+ [ Boundary Conditions
+ ﬂ Mesh Interfaces
< Dynamic Mesh
7] Reference Values
+ 17, Reference Frames
fo Named Expressions
- Solution
%, Methods
.* Controls
(3] Report Definitions
+ @ Monitors
@ cell Registers
&, Initialization
+ # Calculation Activities

® Run Calculation
- Results

@ surfaces
=) @ Graphics
(2 VPN
If] Contours I
“» Vectors
& pathlines

Ve a Results.
Selecciona Graphics y luego Contours.

En Contours of, elige Temperature y Total Temperature.
En Surfaces, selecciona Fluid, Solid, y Wall.
Haz clic en Compute para generar los contornos de temperatura.

Conlour Name

contour-1

Options

v
v
v

Filled

Node Values
Boundary Values
Contour Lines
Global Range
Auto Range

Clip to Range

Draw Mesh

Coloring

Colormap ()ptinn‘:...l )

Banded
Smooth

n Contours

500

Contours of

Temperature...

| otal lemperature

Min

Surfaces Filte

’

+ Inlet
+ Interface
+ Internal

O

—
]

New Surface

Save/ Disply

Compute Ill Close I ‘ Help




2. Guardar y Mostrar Resultados
a. Después de calcular los contornos, haz clic en Save/Display para visualizar
los resultados.
b. Asegurate de que los resultados sean correctos y que las visualizaciones
muestren adecuadamente las distribuciones de temperatura.

contaur-2
Total Tomperature

30%e+02
301e+02
2000+02
300e+02
3.00e+02
300e+07
29%er02
2890+02
259e+0Z

258a0+02

2 58e+02

3. Guardar Todo
a. Guarda tu trabajo y los resultados de la simulacién.
1. Ve a File > Save Project para guardar todo el proyecto de Fluent.
ii. También puedes exportar imagenes de las visualizaciones y datos para
analisis posterior.

' ved Project - Workbench
m Vew Tools Units Extensons Jobs Help

Clhri+D

Cul4s

| Bl SaveAs..

En este manual, hemos guiado a través de los pasos necesarios para simular el enfriamiento
de un tren de baterias utilizando Fluent. La correcta configuracion de modelos, materiales y
condiciones de frontera es crucial para obtener resultados precisos y significativos. Mediante
la visualizacion de contornos de temperatura y la evaluacion de superficies, hemos podido
analizar la distribucion térmica dentro del sistema, proporcionando datos valiosos para el
disefio y la optimizacién de sistemas de gestion térmica en aplicaciones de baterias.

La simulacion en Fluent no solo facilita la comprension de los fendmenos térmicos, sino que
también permite realizar ajustes y mejoras en el disefio inicial de manera virtual, reduciendo
costos y tiempos de desarrollo. Con estos pasos, los usuarios pueden aplicar este
conocimiento para estudios futuros y aplicaciones practicas en la industria de vehiculos
eléctricos y almacenamiento de energia.



